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78KO0/Ix2 LED Control

Demonstration Kit for Renesas Electronics
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Notice

All information included in this document is current as of the date this document is issued. Such information, however, is subject to
change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please confirm the latest
product information with a Renesas Electronics sales office. Also, please pay regular and careful attention to additional and different
information to be disclosed by Renesas Electronics such as that disclosed through our website.

Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights of third
parties by or arising from the use of Renesas Electronics products or technical information described in this document. No license,
express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas
Electronics or others.

You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of
semiconductor products and application examples. You are fully responsible for the incorporation of these circuits, software, and
information in the design of your equipment. Renesas Electronics assumes no responsibility for any losses incurred by you or third
parties arising from the use of these circuits, software, or information.

When exporting the products or technology described in this document, you should comply with the applicable export control laws and
regulations and follow the procedures required by such laws and regulations. You should not use Renesas Electronics products or the
technology described in this document for any purpose relating to military applications or use by the military, including but not limited
to the development of weapons of mass destruction. Renesas Electronics products and technology may not be used for or
incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign
laws or regulations.

Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics does
not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever for any damages incurred by you
resulting from errors in or omissions from the information included herein.

Renesas Electronics products are classified according to the following three quality grades: "Standard”, "High Quality", and "Specific".
The recommended applications for each Renesas Electronics product depends on the product's quality grade, as indicated below.
You must check the quality grade of each Renesas Electronics product before using it in a particular application. You may not use any
Renesas Electronics product for any application categorized as "Specific" without the prior written consent of Renesas Electronics.
Further, you may not use any Renesas Electronics product for any application for which it is not intended without the prior written
consent of Renesas Electronics. Renesas Electronics shall not be in any way liable for any damages or losses incurred by you or third
parties arising from the use of any Renesas Electronics product for an application categorized as "Specific" or for which the product is
not intended where you have failed to obtain the prior written consent of Renesas Electronics.

The quality grade of each Renesas Electronics product is “Standard” unless otherwise expressly specified in a Renesas Electronics
data sheets or data books, etc.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual
equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots.

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support.
“Specific”: Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems;medical equipment or

systems for life support (e.g. artificial life support devices or systems), surgical implantations, or healthcare
intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life.

You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics,
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or damages
arising out of the use of Renesas Electronics products beyond such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have specific
characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further, Renesas
Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to guard them
against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a Renesas Electronics
product, such as safety design for hardware and software including but not limited to redundancy, fire control and malfunction
prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation of microcomputer
software alone is very difficult, please evaluate the safety of the final products or system manufactured by you.

. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of

each Renesas Electronics product. Please use Renesas Electronics products in compliance with all applicable laws and regulations
that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive. Renesas Electronics
assumes no liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

. This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas

Electronics.

. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or

Renesas Electronics products, or if you have any other inquiries.

(Note 1) "Renesas Electronics" as used in this document means Renesas Electronics Corporation and also includes its majority-
owned subsidiaries.

(Note 2) "Renesas Electronics product(s)" means any product developed or manufactured by or for Renesas Electronics.




General Precautions for Handling This Product

1. Circumstances not covered by product guarantee

e |f the product was disassembled, altered, or repaired by the customer

e Ifit was dropped, broken, or given another strong shock

e Use at overvoltage, use outside guaranteed temperature range, storing outside guaranteed
temperature range

¢ If the cable of the power adapter, the USB interface cable or the like was bent or pulled excessively

e |f a power adapter other than the supplied product was used

o If the product got wet

e If this product is connected to the target system when there is a potential difference between the GND
of this product and GND of the target system.

e |f the connectors or cables are plugged/unplugged while this product is in the power-on state.

o |f excessive load is applied to the connectors or sockets

e |f a metal part of the power connection, or another such part comes in contact with an electrostatic
charge.

o If the product is used or stored in an environment where an electrostatic or electrical noise is likely to

occur.

2. Safety precautions

e Parts of board can become hot during operation!

e Do not look into the LEDs directly; doing so may cause weakening eyesight!

e Be careful of electrical shock. There is a danger of electrical shock if the product is used as described
above in 1. Circumstances not covered by product guarantee.

o The power adapter supplied with the product is exclusively for this product, so do not use it with other

products.
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78K0/1x2 LED Control

Introduction

Chapter 1 Introduction
78K0/1B2 HBLED Evaluation Board is part of the 78K0/Ix2 LED Control demonstration kit
for high brightness LED applications using the 78K0/IB2 microcontroller.
This board can operate by DC 5V power supply provided from AC adapter. 78K0/IB2
controls current of the high brightness LED to be constant. It can also control the
evaluation board operating with an analog input. When connecting it with a Lighting
Communication Master Evaluation Board (EZ-0008), LEDs can be controlled to dim with
DMX512 protocol or DALI protocol.
Figure 1-1 System setup example (OCD mode / DALI protocol control)
Power supply (5V, >1A)
Lighting Communication
Board (EZ-0008)
78K0/IB2 HBLED Evaluation board
Programming/OCD (EZ-0005)
1.1 Package contents

e 78KO0/IB2 HBLED Evaluation Board (EZ-0005)
e 5Vbc/2.4A power supply
e USB cable
e One set of plastic stands and screws
e 3 connection cables (DALI, DMX512)
o CD-ROM with Applilet EZ for HCD Controller software and an evaluation copy of the

IAR Embedded Workbench for 78K with 16Kbyte code size limitation
Please verify that you have received all parts listed in the package contents list attached
to the 78K0/Ix2 LED Control package. If any part is missing or seems to be damaged,
please contact the dealer from whom you received your 78K0/Ix2 LED Control
demonstration kit.

1.2 Features

e 3 channels constant current control without driver IC but only a 78K0/IB2

microcontroller

o Buck topology

o 300mA per channel

o 5V supply voltage

R20UT0397EDO000 Rev. 1.10 REN ESNS Page 6 of 47
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Introduction

e Up to 3 kind of control interface supported

o DMX512 protocol communication interface

o DALI protocol communication interface

o Analog volume control interface

e  Programming / On-chip debug supported

1.3 System requirements

HOST PC

Host interface

A PC supporting Windows XP (32bit), Windows Vista (32bit) or
Windows 7 (32bit) is required.

A Pentium processor with at least 1 GHz CPU performance, with
at least 256 Mbytes of RAM, allowing you to fully utilize and take
advantage of the product features. 500 Mbytes of free disk
space and an additional 10 Mbytes of free disk space on the
Windows system drive.

A web browser and Adobe Acrobat Reader to be able to access
all the product documentation.

USB interface that enables communication based on USB
(Ver1.1 or later)

Note: Updates of the IAR Embedded Workbench for 78K, documentation and/or utilities for the
78K0/Ix2 LED Control Starter Kit, if available, may be downloaded from the Renesas

WEB page(s) at http://www.renesas.eu/78K0IX2-LED

1.4 Trademarks

IAR Embedded Workbench, visualSTATE, IAR MakeApp and C-SPY are registered
trademarks of IAR Systems AB. Microsoft, Windows and HyperTerminal are registered
trademarks of Microsoft Corporation. Adobe and Acrobat Reader are registered
trademarks of Adobe Systems Incorporated.

All other product names are trademarks or registered trademarks of their respective

owners.

R20UT0397EDO0000 Rev. 1.10
11. November 2010
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78K0/1x2 LED Control

Hardware

Chapter 2 Hardware
This chapter describes the specification of 78K0/IB2 HBLED Evaluation Board (EZ-0005)
delivered with the 78K0/Ix2 LED Control demonstration kit.
The 78K0/Ix2 LED Control demonstration kit is assembled with a yPD78F0756 8-bit
microcontroller and 3 300mA forward current High Brightness LEDs.
Figure 2-1 Appearance of 78K0/IB2 HBLED Evaluation Board (Top View)
Analog Volume Switch
DC plug
for AC adapter
Connector
for DALI
Connector
for DMX512
USB connector Surface appearance (TOP View)
Figure 2-2 Appearance of 78K0/IB2 HBLED Evaluation Board (Bottom View)
High
Brightness
LED
Surface appearance (Bottom View)
Caution: The part of board especially the area enclosed with RED line becomes high
temperature!
Caution: Do not look into the LEDs directly; doing so may cause weakening eyesight!
2.1 Power supply
The following AC adaptor or dc power supplier is recommended to be applied to
78K0/IB2 HBLED Evaluation board via the Switchcraft RAPC722 (Center pin f 1.93mm,
Plug f 6.3mm (max)).
R20UT0397EDO000O Rev. 1.10 :{ENESAS Page 8 of 47
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Hardware

Figure 2-3

Note:

2.2

Table 2-1

Polarity and shape of DC plug

¢ 6.3[mm]

¢ 1.93[mm]

SRCRO

¢ AC Adaptor
Output voltage :
Output current :
Connector :

3[V]
2[A] (recommend), over 1[A]
refer to figure 4

Switching regulator type with over current protect
circuit. Do not use AC adapter whose output voltage
is guaranteed only when rated load current flows.

Type :

e DC power supplier
Output voltage :
Output current :
Connector :

S[V]
over 1[A]
refer to Figure 2-3

Use AC adapter adapted to safety standard of each country.

DIP switch

The 78K0/IB2 HBLED Evaluation Board uses an 8-position DIP switch (SW502) for
configuration purposes. The following table shows the various configuration options.

Board Configuration Options

Setting
ON OFF

Switch No.

SW1-1 RUN mode for 78K0/IB2 PROG/OCD mode for 78K0/I1B2

SW1-2 Not specified.

SW1-3 Different combination of these three pins can generate varies voltage inputted into

ANIO pin of microcontroller. They are recommended to be used as custom mode

SW1-4 selector.

Enable communication between Reserve for USB microcontroller

78K0/IB2 and USB microcontroller

SWi1-5 . . .
firmware updating without a USB cable.

Enable communication between Reserve for USB microcontroller

SW1-6

78K0/1B2 and USB microcontroller

firmware updating without a USB cable.

SWi1-7

Connect TxD6 pin of 78K0/IB2 tom
lighting communication circuit DMX512

or DALI

Disconnect TxD6 pin of 78K0/IB2 and
communication circuit. User can connect
his own communication circuit to
78K0/IB2 through TP601.

SWi1-8

Connect RxD6 pin of 78K0/IB2 to
lighting communication circuit DMX512

or DALI

Disconnect RxD6 pin of 78K0/IB2 and
communication circuit. User can connect
his own communication circuit to
78K0/IB2 through TP602.

R20UT0397EDO0000 Rev. 1.10
11. November 2010
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2.3 DMX512/DALI switch
To select the wanted communication method DALI or DMX512 SW401 has to be set to
the regarding position.
Table 2-2 Communication switch setting
Setting Communication protocol
1,4 side DMX512 interface
3,6 side DALI interface
2.4 DMX512 Interface
The 78K0/IB2 HBLED evaluation board provides a DMX512 connector to communicate
with other hardware via the DMX512 communication standard. Therefore the connector
is connected to the UARTG interface of the yPD78F0756 microcontroller via the SW401
switch.
Table 2-3 DMX-512 Connectors
Pin Number Function
1 Ground
2 D+
3 D-
2.5 Reset switch
The on-board reset switch (refer to SW501 in the schematics) can be used to reset the
uPD78F0576 microcontroller.
2.6 USB programming and debugging interface
The 78K0/IB2 HBLED evaluation board implements an on-board USB programming and
debugging interface, using the Renesas Electronics yPD78F0730 USB microcontroller.
You can download code to the yPD78F0756 microcontroller from a host computer via a
mini-USB cable, and then proceed to debug that code (for information about debugging
refer to the regarding chapter).
R20UT0397ED0000 Rev. 1.10 RENESAS Page 10 of 47
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78K0/Ix2 LED Control installation and operation

Chapter 3 78K0/Ix2 LED Control installation and operation

3.1 Getting started

The Applilet EZ for HCD Controller allows a GUI based program building and
downloading of application programs to the 78K0/IB2 HBLED evaluation board.
Therefore it is necessary to have a valid IAR Embedded Workbench for 78K installation
on the PC host system. As communication interface between the PC host system and the
78K0/IB2 HBLED evaluation board a standard USB interface line is needed. Before you
can download and run a program, software and hardware have to be installed properly.

3.2 CD-ROM contents

The CD-ROM shows following directory structure:

Table 3-1 78K0/Ix2 LED Control CD-ROM directory structure

78K0IX2-LED

CD-ROM ROOT

—1 Adobe

Acrobat Reader for 32Bit Windows OS

— Applilet

Applilet EZ for HCD controller

L Doc

Documentation

i dotnet

Microsoft .net package

L Driver

78K0/Ix2 LED Control USB driver files

1 IAR Embedded Workbench

IAR Embedded Workbench for 78K

L sample program

Example program for the 78K0/Ix2 LED Control
Starter Kit

— WriteEZ5

Flash Programmer WriteEZ5 incl. PRM file for
uPD78F0576

3.3 Pre-programmed Demo-Application

The 78K0/IB2 HBLED evaluation board is pre-programmed with a demonstration code
that controls the 3 on-board LEDs based on the Analog Volume Switch position.

R20UT0397EDO0000 Rev. 1.10
11. November 2010
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Chapter 4 Hardware Installation

After unpacking the 78K0/Ix2 LED Control demonstration kit, connect the board via
connector CN3 to your host computer using the provided USB interface cable. When
78K0/IB2 HBLED evaluation board is connected, the USB driver needs to be installed on
the host machine. Please refer to the following Chapter 5 Software Installation.

R20UT0397ED0000 Rev. 1.10 PR
11. November 2010 RENESAS
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Chapter 5 Software Installation

The 78K0/Ix2 LED Control package comes with the following software packages:

o AppliletEZ for HCD Controller

¢ |AR Systems Embedded Workbench for 78K 16Kbyte code size limited, including C
compiler, assembiler, linker, librarian and IAR C-SPY debugger / simulator

e Sample project for the IAR Embedded Workbench for 78K
o WriteEZS flash programmer including the PRM file for yPD78F0576

Figure 5-1 78KO0/X2-LED CDROM autorun.exe

Demonstration Kit 78KO0/Ix2 LED Control

=
(™
%

Applilet EZ Installation

IAR Embedded Workbench
Installation

E IAR. Sample project

= Write EZ5 Installation

E Documentation
m Exit

RENESANS

5.1 AppliletEZ for HCD Controller installation

To install the Applilet EZ for HCD Controller just press the regarding button from the
Autorun of the CD-ROM provided within the 78K0/Ix2 LED Control package. The setup
dialogues will guide you through the installation process. The installation can also be
started by executing the AppliletEZforHCD V421E.ms1i in the directory
“\Applilet” of the CD-ROM.

5.2 |AR Systems Embedded Workbench for 78K installation

To install the IAR Systems Embedded Workbench for 78K including C-SPY debugger /
simulator press the regarding button from the Autorun of the CD-ROM provided within the
78K0/Ix2 LED Control package. The installation can also be started by executing the
Autorun.exe program in the directory \TAR Embedded Workbench” of the CD-ROM.
The setup dialogues will guide you through the installation process.

R20UT0397ED0000 Rev. 1.10 e
11. November 2010 RENESAS
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Figure 5-2 IAR Embedded Workbench installation screen

Welcome to IAR Systems
IAR Embedded Workbench® 16K Kickstart for Renesas 78K

QuickStarnt installation information
Install IAR Embedded Workbench®
Install visualS TATE®

Release notes

¥iew the product documentation
Install Adobe Acrobat Reader
Explore the CD

SYSTEMS

WWW_iar.com

D Byryrr=2oe &

Note: To be able to install the IAR Embedded Workbench 16K Kickstart for 78K a License
number and key has to be requested, free of charge, via an online registration.

Figure 5-3 IAR Embedded Workbench License request and install

* H&*ZE (Japanese]

Welcome to IAR Systems

IAR Embedded Workbench® Kickstart installation

You must have a license number and an inztallation kep to install this evaluation version of IAR
Embedded Workbench.

Follow these steps:
1. Click the IAR online registration link below to register on the |AR Systems website.
2. You will receive an email with your license number and installation key within a few minutes.

3. Click the Install IAR Embedded '\.lalrlznkhent:ho link below to start the installation.

IAR online registration

ﬁ Install |1AR Embedded ‘-'.I"lzllkhent:ho

# Back

SIAR

SYSTEMS

WAL IS SO

For further information about the IAR Embedded Workbench installation refer to the
InstallationGuide.ENU.pdf in the directory "\IAR Embedded
Workbench\doc\common\doc” of the CD-ROM.

R20UT0397ED0000 Rev. 1.10 O
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5.3

5.4

5.5

5.5.1

WriteEZ5 installation

To install WriteEZ5 flash programmer just press the regarding button from the Autorun of
the CD-ROM provided within the 78K0/Ix2 LED Control package. The setup dialogues
will guide you through the installation process. The installation can also be started by
executing the WriteEZ5 v100 r3 EE.exe inthe directory “\WRITEEZ5” of the
CD-ROM.

Sample program installation

To copy the IAR sample project to the Host PC hard drive press the regarding button
from the Autorun of the CD-ROM provided within the 78K0/Ix2 LED Control package. The
setup dialogues will guide you through the copying process. The copy can also be started
by executing the 78K0IX2-LED sampleproject V110.exe in the directory
“\sample program” ofthe CD-ROM.

USB Driver Installation

In order to use the 78K0/IB2 HBLED evaluation board the USB driver needs to be
installed on the host machine. Install the driver according to the following procedure:
Installation on Windows XP Page 15

Installation on Windows 7 Page 19
Installation on Windows XP

1. When the 78K0/IB2 HBLED evaluation board is connected with the host machine,
the board is recognized by Plug and Play, and the wizard for finding new
hardware is started. At first the hardware wizard will ask if windows should search
on the windows update web, check "No, not this time" and then click [Next>].

Figure 5-4 Found New Hardware Wizard 1 (Windows XP)

Hardware Update Wizard

Welcome to the Hardware Update
Wizard

Wwindows will search for current and updated zoftware by
loaking on your computer, on the hardware inztallation CO, or on
the Windows Update 'web site [with your permission).

Read our privacy policy

Check that "No, not this time"
is selected.

Can*indows connect to Windows Update to search for
software?

() Yes. this time orly

() ¥es, naw and every time | connect a device .
N Click.
Click Neust to continue.
Mest » l ’ Cancel
2. Check that "Install from a list or specific location (Advanced)" is selected, then
click Next>].
R20UT0397ED0000 Rev. 1.10 RENESAS Page 15 of 47
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Figure 5-5 Found New Hardware Wizard 2 (Windows XP)

Hardware Update Wizard

Check that "Install from a list or
specific ..." is selected.

Thiz wizard helps you install zoftware for:

MEC Electronics Starter Kit Yirtual UART [COME)

Z:'J If your hardware came with an installation CD
“ZE2 or floppy disk, insert it now.

What do wau wart the wizard to do?

() Inztall the software automatically [Fecommended)
(=) install from a list or specific location [Advanced}

Click.

3.

Click Mest to continue. /

< Back " Mest » ][ Cancel ]

Check that "Search for the best driver in these locations." is selected. Select the
"Include this location in the search:" check box and then click [Browse].

Figure 5-6 Search Location Specification 1 (Windows XP)

fHardware Update Wizard

<1>

Check that "Search
for the best driver in
these locations." is
selected.

Please choose your search and installation options. o

N

(%) Search for the best driver in these lozations.

Ize the check boxes below to limit or expand the default search, which includes local

paths and removable media. The best diver found will be installed.

[]Search removable media [floppy, CO-ROM...)

<2>

Check "Include this
location in the
search:" only.

Include this location in the search:

() Dan't search, | will choose the driver ta install

Choose this option ta select the device driver fram a list. Windows does not guarantee that

4.

the diiver you choose will be the best match for your hardware.

s

’ < Back ”_ Mewut > l[ Cancel

<3> Click.

Locate the folder "C CDROM:\Driver\WIN_2K_XP_32" and click @

R20UT0397EDO0000 Rev. 1.10
11. November 2010
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Figure 5-7 Search Location Specification 2 (Windows XP)

rBruwse For Folder E]w

Select the Folder that contains drivers For wour hardware,

= e 7EKOTXZ-LED (1) N
) Adobe
[ Applilet

) Doc
) dotnet
= [C3) Driver
O
I wWiIN_vISTA_7_3

[C3) 14R Embedded wWorkbench

|5 sample program [v]

To wiew any subfolders, click a plus sign above.

(0] 4 H Cancel l

5. As shown below, "NEC Electronics Starter Kit Virtual UART has not passed
Windows Logo testing to verify its compatibility with Windows XP." is displayed.
Click [Continue Anyway|.

Figure 5-8 Windows XP Logo Testing (Windows XP)

Hardware Installation

L) E The software you are inztalling for this hardware:
L3
MEC Electronics Starter Kit Witual LART

haz not pagzed Windows Logo testing to verify its compatibility
with Windows XP. [Tell me why thiz testing iz important. ]

Continuing your installation of this software may impair
or destabilize the comrect operation of your spstem
either immediately or in the future. Microsoft strongly
recommends that pou stop this installation now and
contact the hardware vendor for zoftware that has
passed Windows Logo testing.

Click.

[ Continue Anyway ] | STOF Installation |

6. After the installation of the USB driver is completed the window below is
displayed. Click to close the hardware wizard.
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Figure 5-9 USB Driver Installation Completion (Windows XP)

Found MNew Hardware Wizard

¢ Completing the Found New
Hardware Wizard
The wizard haz finizhed instaling the software for:

Kg MEL Electronics Starter Kit Virtual UART

Click.
Click Finish to close the wizard. /
—r—
7. After installing the USB driver, check that the driver has been installed normally,

according to the procedure below. When using the 78K0/IB2 HBLED evaluation
board the “NEC Electronics Starter Kit Virtual UART” should be present like in the

figure below.

Please check in the Windows "Device Manager" within the Windows Properties
(“Hardware” tab), that the driver is installed normally.

Figure 5-10 Device Manager driver correctly installed (Windows XP)

Device Manager

mEx]

File  Acktion Yiew Help

m & 20 &

+ j Computer
+]-age Disk drives

¥ fﬁ Display adapters

+ g DVDYCD-ROM drives

+-i= Floppy disk controllers

+ 3 Floppy disk drives

+|-{d5 Human Interface Devices

+ IDE ATAJATAPT controllers
+|-&9 IEEE 1394 Bus haost contrallers
+-@ Kevboards

+- ") Mice and other pointing devices
-

= Monitors
+-H8 Mebwork adapters
- 9 Parts (COM & LPT)
# Communications Port (COM1)
(#i MEC Electronics Starter kit Virbual UART (COME)
+- %8 Processors
+ @% SC51 and RAID controllers
+- 8, sound, video and game controllers

+-Ege Storage volumes

+- b System devices
+ Universal Serial Bus controllers
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5.5.2 Installation on Windows 7

When the 78K0/IB2 HBLED evaluation board is connected with the host machine, the
board is recognized by Plug and Play, and the wizard for finding new hardware is started.
When firstly installing a Renesas Demonstration Kit, that uses the Virtual COM port driver,
the automatic installation will fail. Therefore the USB driver has to be installed manually.
To do so please follow the instructions below:

1. Press the Start Button and type “Device Manager” into the text box. Select the
Device Manager from the available search results

Figure 5-11 Open device manager (Windows 7)

Control Panel (3)
=y Device Manager

r@ View devices and printers

=y Update device drivers

- Seemore results

Device Manager x| | ¥ Shut down | » |

2. The 78K0/IB2 HBLED evaluation board is listed as “Unknown device”. Right click
on the “Unknown device” entry and select “Update driver”.
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Figure 5-12 Locate Device to manually install USB driver (Windows 7)

£ Device Manager = EEE| 5
File Action View Help
ke ANz 8 7 Bl

< dud62s Wiz

> {8 Computer

> =y Disk drives

> Display adapters

b e DVD/CD-ROM drives
-4 Floppy disk drives
L_;L,?I Floppy drive controllers
ﬂ% Human Interface Devices
g IDE ATA/ATAPI controllers
22 Keyboards

--ﬂ Mice and other pointing devices .
| Monitors nght

-&F Network adapters Click.
-|l5 Other devices
|l Unknown device

T Ports (COM & LPT)
I Processors

-% Sound, video and game controllers

T T T T T T T T

> {8 System devices
5 o i Universal Serial Bus controllers

3. Select “Browse my computer for driver software” to locate and install the driver

software manually

Figure 5-13 Select driver search method (Windows 7)

\\::/j [ Update Driver Software - Unknown Device

How do you want to search for driver software?

= Search automatically for updated driver software
for your device, unless you've disabled this feature in your device installation

settings.

=» Browse my computer for driver software
Locate and install driver software manually.

Windows will search your computer and the Internet for the latest driver software

\ Click.

Cancel
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Figure 5-14 Search Location Specification 1 (Windows 7)

4.

Click to locate the USB driver location.

@ [ Update Driver Software - Unknown Device

Browse for driver software on your computer

Search for driver software in this location:

F\Driver\WIN_VISTA_7 32

[¥] Include subfolders

# Let me pick from a list of device drivers on my computer
This list will show installed driver software compatible with the device, and all driver

software in the same category as the device,

- Browse... \

Click.

[ MNexdt ][ Cancel

5.

Locate the folder "CDROM:\Driver\WIN_VISTA_7_32" and click [OK].

Figure 5-15 Search Location Specification 2 (Windows 7)

Browse For Folder

Select the folder that contains drivers for your hardware.

a4 7BKOLK2-LED (F:) E
. Adobe
J Applilet

> i Doc

. dotnet

m

a | Driver
| WIN 2K XP 32 L
| WIN_VISTA 7 32

> [} IAR Embedded Workbench B

Folder:  WIN_VISTA_7_32

[ Ok ]l Cancel ]

6.

Press when the correct search path is inserted in the “Search for driver in

this location:” field.
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Figure 5-16 Search Location Specification 3 (Windows 7)

@ [ Update Driver Software - Unknown Device
Browse for driver software on your computer

Search for driver software in this location:

FM\Driver\WIN_VISTA_7 32 ot Browse...

[¥] Include subfolders

# Let me pick from a list of device drivers on my computer
This list will show installed driver software compatible with the device, and all driver
software in the same category as the device,

[ ﬂextwj[ Cancel |

Click.
7. Based on the Windows 7 security settings the “Would you like to install this
device software” dialogue can pop up. If so press [Install.
Figure 5-17 Windows security information (Windows 7)
Windows Security
Would you like to install this device software?
Name: NEC Electronics Ports (COM & LPT) Click.
s Publisher: Renesas Electronics Corporation
[T] Always trust software from "Renesas Electronics | Install | [ Don't Install
Corporaticn”.
';E' You should only install driver software from publishers you trust. How can [ decide which device
software is safe to install?

8. After the installation of the USB driver is completed the window below is
displayed. Click to close the hardware wizard.
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Figure 5-18 USB driver installation completion (Windows 7)

U [l Update Driver Software - NEC Electronics Starter Kit Virtual UART (COM3)

Windows has successfully updated your driver software
Windows has finished installing the driver software for this device:

MEC Electronics Starter Kit Virtual JART

After installing the USB driver, check that the driver has been installed normally,

according to the procedure below. When using the 78K0/IB2 HBLED evaluation
board the “NEC Electronics Starter Kit Virtual UART” should be present like in

the figure below.

Figure 5-19 Device Manager driver correctly installed (Windows 7)

=4 Device Manager
File Action View Help

&< T B HmE| & F %S

(=% R =)

a2 dud3623_ W732

> -1 Computer

b g Disk drives

b ‘& Display adapters

b -y DVD/CD-ROM drives
-2 Floppy disk drives

-1:‘;?‘ Floppy drive controllers

EQE, Human Interface Devices

> - IDE ATA/ATAPI controllers

<= Keyboards

--B Mice and other pointing devices
‘_- Monitors

> ¥ Network adapters

I Portable Devices

3 Ports (COM &L LPT)

E 1-? Communications Port (COML)
"7 MEC Electronics Starter Kit Virtual UART (COMB3)
¢ LT Printer Port (LPTL)

b ) Processors

-% Seund, video and game controllers
b 1M Systern devices

b - a Universal Serial Bus controllers

Fl
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Chapter 6

Applilet EZ for HCD Controller

Applilet EZ for HCD Controller is a tool used to automatically generate software for
microcontroller uPD78F0756, which is used to control the high current driver.

The software can be easily generated by specifying the setting and operation of the
uPD78F0756 on the GUI. The generated software can be directly written to the flash
memory of the yPD78F0756 via a USB cable and an operation check can be performed
by using the 78K0/IB2 HBLED evaluation board.

By using Applilet EZ for HCD Controller, an application system that uses the
uPD78F0756 can be introduced without requiring a detailed knowledge of complex
programming languages. Furthermore, labor for software development for
microcontrollers, which used to take a long time, and operation checking can be
significantly reduced.

For a further information please refer to the “Applilet EZ for HCD Controller User’'s
Manual” which can be found in the “CDROM:\Doc\Applilet EZ\” folder.
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Chapter 7 Using the Applilet EZ for HCD Controller

In the following chapter the different functionalities of this tool will be explained in short
exercises. Exercise 1 and 2 can be used as short quick start example to light up the
LEDs mounted to the 78K0/IB2 HBLED evaluation board. The exercise 3 to 5 will give a
further description of the possibilities in usage of the Applilet EZ for HCD Controller.

7.1 Exercise 1 — Applilet EZ for HCD Controller settings

This exercise will go through the Applilet EZ for HCD controller’s general settings.

1. Open the Applilet EZ for HCD Controller. Click Start > All Programs - NEC
Electronics Tools = Applilet EZ for HCD - Applilet EZ for HCD.

Figure 7-1 Applilet EZ for HCD Controller Main Window

% Untitled - Applilet EZ for HCD Controller (=)
Bile Project Buld Setting Help

[ &

Mew  Open

Target Diirarner Pragram
Board

CPU
UARTE: |'|

UARTO:

C5l

IIC:

2. Under the Project menu all of the MCU settings will be listed for configuration.
Select CPU.

Figure 7-2 Applilet EZ for HCD Controller Setting

48 Untitled - Applilet EZ°
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Figure 7-3

3. In the CPU settings you will notice that the Target will be EZ-0005(EZ-LED1-002).
Under the Clock Source you can select the internal 20MHz oscillator.

Applilet EZ for HCD Controller CPU settings

Board Property
Target: \EZO00S[EZLED1-002) v/
Device: uPD7BFO7SE_30 [] Enable '0n Chip Debug'.
Clack Source: | Intermal ozc. [v]
Frequency [MHz]:| 20 [v]

Channel 1: |+| Enable Calor; . |_| [ ] &l Channel Sunchrorized,

Channel 2: [+ Enable Caolor: |:| |‘ [] Logarithmic: dimming contoral.

Chenrel 2 |¥] Enable Colar: . |‘|
Channel 4: |'|

| ok || cencEL

4. The Applilet EZ for HCD Controller is able to use the Renesas Compiler for 78K0
as well as the IAR Embedded Workbench for 78K. To select click Setting >
Compiler and choose the IAR compiler when using the Applilet EZ for HCD
Controller with the 78K0/Ix2 LED Control starter kit.

Figure 7-4 Applilet EZ for HCD Controller Compiler selection

Note:

tpphilet EZ for HCD Controller
iild | Setking  Help

Compiler 3 CC7aKD
w [AR
FLASH Program...
Folders... er Program
JOOS(EZ-LEDT-002 (@)

Make sure that you have installed the selected compiler correctly to your PC host
system before building the project.

5. Now take a look at the output folder option, select Setting 2> Folders... These
locations will specify the output paths of the generated files. Enter in your desire
destination but keep in mind that Applilet EZ will create subdirectories under this
folder for each Applilet EZ project. Click OK.

Figure 7-5 Applilet EZ for HCD Controller Folder Setting

Folder Setting
Save to:
C:ADocurnents and SetingshHCD E]
Froject:
C:ADocurnents and SetingshHCD E]
[ ok [ cewcer |
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7.2 Exercise 2 — Fix dimmer program

This program set a fixed duty value for each of the 3 LED channels. Make sure that all
settings, like explained in Exercise 1, are still correctly set for this exercise.

1. Make sure “Fix” is still selected as the dimmer program
2. Input “2” to all the channels so they are not too bright.

Figure 7-6 Applilet EZ for HCD Controller LED channel settings

Drirarmer Program
(%) Fix
Ch1 duty: 2| Ch2Duly: 2 Ch3Duly 2

: Duty patameter available 0- 28
Select . '|

3. Save the Applilet EZ project (.xml). We will save the new Applilet EZ project
name to fix.xml. Select File > Save as.. and input “fix.xml” and then click
Save.

Figure 7-7 Applilet EZ for HCD Controller Save File as (fix.xml)

rSave As W
Save jn; | | HCD [V] Q¥ -

File name: fise = Save

Cave as hype: |Save Filez [* xml] [V] [ Lancel ]

4, Make sure to remove the power cable from the 78K0/IB2 HBLED evaluation
board. Click the All P. Button. Make sure that SW502.1 of the Switch Dip is in the
OFF position which is the programming mode and then insert the USB
connector.

Figure 7-8 Applilet EZ for HCD Controller All Program button

All P
5. You will be informed about the progress of the compilation.
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Figure 7-9 Applilet EZ for HCD Controller compilation progress

Build

Create the project folder.
Generate C code.

Start Compilation,
HE#-file "'ez005.hex" was created.

6. Next click OK when prompt to start flash programming.

Figure 7-10 Applilet EZ for HCD Controller Start Flash programming

AppEzHCD
\j_) Stark FLASH programing.
: (o4 { [ Cancel
7. During the flash procedure you will be informed about the actual status of the
download
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Figure 7-11 Applilet EZ for HCD Controller Flash programming status

-,

Build

Create the project folder.
Generate C code.

Start Cornpilation.
HE>file “"ez005 hex'' was created.

Start FLASH programing.
HE file wasz read.

Flash Blank Checking...

not blank, then eraze.

Flazh Erazing...

chip eraze finish.

Flash Programming Start...
Flazh Programming <105 ..
Flash Programming <205
Flazh Programming <3052 .
Flash Programming <405
Flazh Programming <505 .
Flash Programming <GB0
Flazh Programming <705 ..
Flash Programming <805
Flazh Programming <305 .
Flash Pragramming finizhl

8. Click CLOSE to exit the “Build” window. Remove the USB and change SW502.1
to the on position for run mode. Insert the power connector or the USB cable to
the board and you should see the LEDs light up to finish this exercise.

e HP-LED1(channel 1) = Red
e HP-LED2(channel 2) = Green
e HP-LED3(channel 3) = Blue

Caution: Do not look into the LEDs directly; doing so may cause weakening eyesight!

7.3 Exercise 3 — Variable dimmer program

This program sets the duty value for each channel given by drawing pattern data.
1. Make sure that you have set all the settings as explained in Exercise 1.

2. Save the new Applilet EZ project name to variable.xml. Select File > Save as..
and input “variable.xml” and then click Save.
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Figure 7-12 Applilet EZ for HCD Controller Save File as (variable.xml)

2

Save As
Save jn: [ ) HCD 3 ¥ > -
=
=i
File name: wariable. sl
Save az buper | Save Files [*xmi] w
3. Now we have a new Applilet EZ project file and we will change the dimmer

program to “Variable”.

Figure 7-13 Applilet EZ for HCD Controller Dimmer Program selection (Variable)

{# Variable

Edit

5. Click on the “Edit” button under “Variable” and the “Variable Dimmer Control”
window will open. Enter “600” for the data size and enable the “Cyclic” check
box. Click the Ch.1 button to select this channel for modification. Select the line
Mode as shown below. This will allow you to draw the PWM duty cycle versus

time by using your mouse pointer.

Figure 7-14 Applilet EZ for HCD Controller Variable Dimmer Control settings (clean)

DIMMER PROGRAMING

Maode Ediit

Ky

(@il
ch.z:
(driah
Ch.4:

el

u]

Data Size: | 600 | Points  (1-600, 10points/s).

a0

Cyclic

50
[sec]

ok J[ cemce |
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7. Draw something close to the sinusoidal wave below and then click OK.

Figure 7-15 Applilet EZ for HCD Controller Wave Editor (set)

DIMMER PROGRAMING

Maode Edit

Ky

Ch.1:
Ch.z2:
@2k
ch.4:

u} a0 50
[sec]
Data Size: | 600 | Points  (1-600, 10points/s). [ Cyclic [ oK ” CAMCEL ]
8. Repeat the same process for the red channel to the remaining 2 channels. When

done, click on the OK button to exit the variable dimmer control window.

Figure 7-16 Applilet EZ for HCD Controller Variable Dimmer Control settings (set)

DIMMER PROGRAMING

Made Edit

B

ERH

Isfy8IE
ch.z:
(dri2h
Ch.4:

u] a0

Data Size: | 600 | Points (1-600, 10pointsfs), [¥] Cyclic

G0
[sec]

Ok

[ cance
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9. Make sure that the 78K0/IB2 HBLED evaluation board is in programming mode
(SW502.1 set to OFF) and the USB cable is connected correctly. Click the save
button and afterwards the All P. button. After downloading the application
disconnect the USB and set the 78K0/IB2 HBLED evaluation board in the run
mode as described in Exercise 2 point 7. You should now see the LEDs on the
board running the variable dimming application based on the wave table drawn.

Caution:

7.4

Do not look into the LEDs directly; doing so may cause weakening eyesight!

Exercise 4 — DMX512 communication protocol program

This sample shows how to set up the Applilet EZ for HCD Controller to program the
DMX512 stack into the yPD78F0756 assembled to the 78K0/IB2 HBLED evaluation

board.
1. Make sure that you have set all the settings as explained in Exercise 1.
2. Save the new Applilet EZ for HCD Controller project with the name DMX512.xml.

Select File > Save as.. and input “DMX512.xml” and then click Save.

Figure 7-17 Applilet EZ for HCD Controller Save File as (DMX512.xml)

-

Save As

Bx]

Save in; | Iy HCD

Mot oo

x| Er

Fioe el

ol H
variable, xml

File name: DibA=51 2 il
Save as tpe: |Save Filess [, mnl] [v] [ Cancel ]
3. Open the DMX512 Property dialogue box by Project > DMX512... and check

that the settings are chosen as shown below.

Figure 7-18 Applilet EZ for HCD Controller DMX512 Property dialogue box

-,

DMX512 Property
Channel 1 Channel 2 Channel 3 Channel 4
Slat: A Slot: | 2 Slot: 3
Slot available 1-512,
ok || canceL
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4. Select the DMX512 Dimmer program.

Figure 7-19 Applilet EZ for HCD Controller DMX512 select

() D512

5. Make sure that the 78K0/IB2 HBLED evaluation board is in programming mode
(SW502.1 set to OFF) and the USB cable is connected correctly. Click the save
button and afterwards the All P. button. After downloading the application
disconnect the USB and set the 78K0/IB2 HBLED evaluation board in the run
mode as described in Exercise 2 point 7. You should now be able to control the
LEDs on the 78K0/IB2 HBLED evaluation board via the DMX512 protocol by a
connected DMX512 master device (for example the Renesas Electronics
demonstration kit 78KO-LIGHTCOMMS)

7.5 Exercise 5 — DALI communication protocol program

This sample shows how to set up the Applilet to program the DALI stack into the
WPD78F0756 assembled to the 78K0/IB2 HBLED evaluation board.

1. Make sure that you have set all the settings as explained in Exercise 1.

2. Save the new Applilet EZ project name to variable.xml. Select File > Save as..
and input “DALLxmI” and then click Save.

Figure 7-20 Applilet EZ for HCD Controller Save File as (DALI.xml)

-

Save As

Save in: | i HCD

IC)DMxE12
I3 Fice

|5 warisble

= DM#EE12
= Fiog, el

(= wariable.xml

File name: DLl wml
Save as lpe: | Save Files [ xml] [v] [ Cancel ]
3. Open the DALI Property dialogue box by Project > DALL... and check that the
settings are chosen as shown below.
R20UT0397EDO000 Rev. 1.10 RENESAS Page 33 of 47

11. November 2010



78K0/1x2 LED Control

Using the Applilet EZ for HCD Controller

Figure7-21 Applilet EZ for HCD Controller DALI Property dialogue box

DALI Property
Wergion 0
Shart 0 ] Group &
Fandom 0 [1Group3
[NGroup 2 [ ]Group 10
Physical Min. 1
[NGroup 3 []Growp 11
Power{n ! [JGrowp4 [ Group12
Systern Failure Level: | 0O [Graups []Group13
Mz 254 [Growp &[] Group 14
M 1 [NGroup 7 [ ]Group 15
Fade 1
Fade 0
[ ok [ cewcer |
4. Select the DALI Dimmer program.

Figure 7-22 Applilet EZ for HCD Controller DALI select

{+) DALI

5. Make sure that the 78K0/IB2 HBLED evaluation board is in programming mode
(SW502.1 set to OFF) and the USB cable is connected correctly. Click the save
button and afterwards the All P. button. After downloading the application
disconnect the USB and set the 78K0/IB2 HBLED evaluation board in the run
mode as described in Exercise 2 point 7. You should now be able to control the
LEDs on the 78K0/IB2 HBLED evaluation board via the DALI protocol by a
connected DALI master device (for example the Renesas Electronics
demonstration kit 78 KO-LIGHTCOMMS).
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Chapter 8 Flash Programmer WriteEZ5

The WriteEZS5 is a flash programming software to flash hex files to the related device. For
installation information refer to the chapter WriteEZ5 installation.

Figure 8-1 WriteEZ5 Startup

"= WriteEZ5 o3

File Device View Help
P& 7 & ¥
Flash Open OK Mame :

b > FlazhDpenning....

»» ParameterFile Reading.... Firmuare :
ParameterFile Read Error

»» LoadFile Reading....

Success read HEX fils.

Device

Parameter file
Mame : FEFO075E. prm
Wersion :

Load file
Mame EZ-0005_SAMPLESOF
Date:  2010/11/1013:49:43
Chksum : CECZh
Area:  000000h-000845h

Cannection ta device

Part :

Speed

Range

Freq.: Internal-O5C
bultiply - 1.00

Ready MM

8.1 Device Setup

To provide all necessary information about the device to be programmed, only the
corresponding flash parameter file must be loaded. The parameter file (*.prm) for the
uPD78F0756 is located on the CDROM, in the same folder as the WriteEZ5 setup file.
Please use the menu “Device = Setup...“ to open the following dialogue and the button
“PRM File Read” to select the parameter file.

Figure 8-2 WriteEZ5 Device Setup Dialogue
2l Device Setup

Standard l Advance ]

Parameter file [78F075E6.prm FRM File Read

Host connection Supply ozcillatar
Port  [coma - Frequency
Speed bultiply rate

Operation Mode

= Chip Start
" Block End

QK | Cancel |

Please check that the correct host communication port is selected. The used
communication port can be seen in the Windows Device Manager.
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8.2 Using WriteEZ5

After a successful device selection the internal flash memory can be blank-checked,
erased, programmed and/or verified. WriteEZ5 can be controlled either by menu or by
buttons.

Figure 8-3 WriteEZ5 Device Menu

s WriteEZ5 B[]

File | Device “Yiew Help

/ﬁ Blank Check
7 Erase

b Fl Program Device

Flast  Verify Marne :

»» P Firrmware :

Para

=3 L

SHed Farameter file
AR R R Mare 7EF075E prm

ersian :

Setup. .. Load file

Mame EZ-0005 SAMPLESOF
Date: 20010/114013:45:49
Chkzum : CECZh

Area:  D000ODh-000849R

Connection to device

Part :

Speed

Range

Freq. :  Intermal-05C
bulbiply - 1.00

ML

Table 8-1 WriteEZ5 action buttons

device setup button

load file button

blank check button

erase button

program button

verity button

erase / program / verify button

WriteEZ5 supports Intel-Hex and Motorola S-record file formats as input file
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Chapter 9

9.1

Figure 9-1

IAR Embedded Workbench sample project

The following chapter describes the necessary steps to set up an IAR C-SPY debug
session using the 78K0/IB2 HBLED evaluation board with the sample project provided on
the 78K0/Ix2 LED Control CD-ROM. This chapter will not deal with deeper information
about the IAR Embedded Workbench but only how to start a C-SPY debug session on
the evaluation board. For further information about the IAR Embedded Workbench for
78K please refer to the regarding User's manuals from IAR Systems.

Load the IAR Embedded Workbench sample project

After copying the IAR sample project to the hard drive of your Host PC as described in
chapter 5.4 Sample program installation you shall be able to run this sample project.

To start the IAR Embedded Workbench 16K Kickstart for 78K click Start > All
Programs - IAR Systems > IAR Embedded Workbench for 78K v4.70 Kickstart >
IAR Embedded Workbench.

The Embedded Workbench starts up and shows the IAR Information Center for Renesas
78K. To open the sample project workspace press the File > Open - Workspace...
and locate the EZ-0005_samplesoft.eww file in the sample program folder.

IAR Embedded Workbench Information Center

JZ IAR Embedded Workbench IDE
File Edit Yiew Project Tools Window Help

DELd I

Www_lar.com/resources

Read in-depth articles from our software engineers and
product managers, see video presentations and check
the webinar calendar or view the recordings.

Guidelines for setting up Complete product Example applications
your project. adding documentation in PDF that demonstrate

files, compiling, linking, format gives you all the herdware peripherals for
and debugging it. user and reference spedific devices and

information you need evaluation boards Www_lar.com/mypages
Create your user account and download product updates
from MyPages. Here you can also manage your contact
information and check your license and SUA status.

Tuterials to make you For questions about how All about the latest
familiar with the IDE to use your IAR produdt, features, new device
and the features of the reporting a problem, or support, end program
1AR C-SPY debugger. finding support comections

resources.

£ || 0 JJ

Ready MM

The project shall show up on the left side of the IAR Embedded Workbench window in
the Workspace view.
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Figure 9-2

9.2

Figure 9-3

IAR Embedded Workbench IDE view

2 IAR Embe dded Workbench IDE =)
File Edit Mew Project Tools Window Help
DEEHE S i o Y wuEee b TNHS (S5
Workspace > |[E—— -x%
[Debug = e j
Filos B i:g : Pdrdm&t:rs:
' voi
B (JEZ-0005_samplesoft - Debug v | lnaes
dimming.c ! 155 #+# Retwrns:
hdwinit.c | 15g s void
main.c | 157 ==
L@ output i 158 *
[ EZ-0005_samplesof d26 | 159 % H
L B Ez-0005_samplesoftmap | 180
i\ 16lrvoid main(woid)
| 162{
| 163 unsigned char i;
| 164 lad
| 185 initiglize dimmer prograk and LED lighting control
| 188 3
187 dim_ini{):
| 168
| 169 #
} 170 start DX0, DI for PR output
L 3
P12 THOTHMC=0M; AEstart
L TAITHC=0H; SEstart
| 174
£Z-0005_samplesolt | 17l 1] | D
= z
‘ WMessages | File
i £3 i | [
- Build [Find in Files [Debug Log x
Ready Errars 0, Warnings 0 Ln 161, Cal 1 [ UM = i

Build and Debug

Before building the project please check that MINICUBE is selected as Debugger Driver.
Therefore open the Debugger settings by clicking Project - Options and select the

Category Debugger.

IAR Embedded Workbench Debugger Settings

Options for node "EZ-0005_samplesoft”

Categon:

zeneral Options
CHC++ Compiler

Factory Settings |

™ Use macro file

Assembler
Custom Build Setup | Extra Options | Images I Pluging I
Build Actions .
Linker Diriver
Debugger IMINIEUBE LT!B-?SKDMINI,E!B-?BKDS:-:xxMINI,QB-MINI2;|
LE-78 ¥ Runto
IECLBE -
MINICLUBE Jmzin
Sirnlator — Setup macra
TE-75

|

— Device description
[~ Oweride default

|

Cancel |
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IAR Embedded Workbench sample project

Table 9-1

Figure 9-4

To be able to run the sample project, connect the 78K0/IB2 HBLED evaluation board to
the Host PC and the power supply, with the following SW502 switch setting chosen.

Switch settings for OCD

SW502.1 OFF
SW502.2 Don’t care
SW502.3 Don’t care
SW502.4 Don’t care
SW502.5 ON
SW502.6 ON
SW502.7 OFF
SW502.8 OFF

When the 78K0/IB2 HBLED evaluation board is connected correctly to the Host PC and
MINICUBE is selected as Debugger driver you shall be able to build, download and

debug the sample project. Therefore just press the Download and Debug button ( 2 )
or click Project > Download and Debug. After downloading the sample project to the
target device the IAR C-SPY debugger shows up and the program shall be stopped at
the beginning of the main() function.

IAR C-SPY debugger window

% AR Embedded Workbench IDE =%
File Edit Wiew Project Debug Emulator  Tools Window Help
Ledd@ & 23| MR AN X AR e A ¥
BsoB Bl =08 25 L2820 K|
= = %
main.c | SA—
T 148 #= 2.5Rift A/D channels. Z] Goto =] [Memery [= | E
3 150 #+ 3.5et system to halt mode after A/D restarted to save energy. [A]
L5l + 04ED 710BE2 CLR1 IF1.0
| 1BZ #+ Darameters:
D res el 04F0 710EEE CLR1 HK1 .0
e 04F3 138C06 HOV TCL51.
1 155 #% Returns:
| 156+ i 04F¢ 1341FF HOV CRE1, #
LR 04F9 71IAEE SET1  MKL.3
| 158 = _]
| 158 % 04FC AF RET
| 180
%! 161void wain(void)
Y Por s e s
163 unsigned char i;
| 154 e 04FE 946703 CALL dim_ini
3 i:; initialize dimmer program and LED 1ighting controi S F17ATE SET1 THOCTLO
| dim ini); 0504 717494 SET1 TH1CTLO
| 168
[ - 0507 717443 SET1 THCSL .7
f 170 start DIX0, DXL for WM output 0504 710425 SET1 ADMO 0
[oAgn i
(s TXOTHC=0H 050D BELAFC HOV A, ucve
Lo173 TXITHC=0H: 0510 FZ0E HOV S:ADS,
; - ~
| iva
Lol 1« | 03 [ £ ST [2]
x | = —
Log &l Gow | =1 [Memar BIEIRIE
Wed Jul 29 13:28:18 2009 Loaded debugee: CiDocuments and SetingsiSp 0000 £6 02 £f ff ff £f ff ff [A]
Wad Jul 29 13:28:18 2009: Target reset oooe  f£f ff ff £f £f £f £f ff e
Wed Jul 29 13:28:18 2009 78K0 MINICUBE Executor'v2.08 LI s i b i s
0018 £f £f £f £ ff £f £F £f
DCD Control Code %3.00 0020 £ £f £f ££ £f £ £f if
Device chipname: uPD78F0756_30(1075630). file version: %1.00 = 0028 f£f ff £f ff ff ff £f ff
Boardinfo: 00008504 cluct id: 4100 : A, - 04.06f 0030 £f ff E£f £f ff £f £f ff
\"\f?ﬂdr’Jm‘;g]aa1 U?,ZET’DDQEIJ— l \/EfS\DnA, IFMWaEre version: 0033 £f ff ff ff ff ff ff if
ey argehieget wl| | 0040 £t £f ££ ££ £ £f ££ €
(3| = | Bl 0048 £f £f EE £ £f Ef £F £f
0050 £f f£f £f £ ff £f £f ff
Debug Log [Buld x 0058 £f £f £f £ £f Ef £F ff
Ready |tn 161, Cal1 HUM =

To run the application press the Run button= . When the program is running you are
able to dim the 3 high brightness LEDs (D101, D201 and D301), mounted to the
78K0/IB2 HBLED evaluation board, just change the position of the variable resistors
VR601, VR602 and VR603.

Caution: Do not look into the LEDs directly; doing so may cause weakening eyesight!
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9.3

9.3.1

Sample Project Flow chart

The following flow chart diagrams show the functionality of the 78K0/Ix2 LED Control IAR
Embedded Workbench sample project.

Main loop

Reset Start

Dimming
Initialization

TMXn start

TM51 start

ADC power on
Select ADC channel
Wait for more than
1us
ADC start

YES

Read out the
ADC result

Measured
Feedback
CHO ?

YES

NO

NO

Measured
Feedback
CH17?

NO

TMIF51 is
ON?

A 4
Set ADC channel

Feedback
pro%e'jg for Measured NO
YES Feedback
CH2?
Feedback
process for
CHI Measured
YES Volume
CHo ?
Feedback
process for
CH1 Measured
YES Volume
CH1?
CHO
Dimming
Measured
YES Volume
CH2?
CH1
Dimming
CH2
Dimming
I
4

NO

Set ADC to next Feedback
cha?/r;ehlﬂtsenext channel
v
Clear ADC
flag
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9.3.2 CHn feedback function (n=0, 1, 2)

CHn feedback

ADC result
almost
equals to 0

NO

ADC result increased
Set TMXn to or kept the same &&
OUtpUt the target ADC result is over
the upper limit && the
Duty is able to be set
lower
ADC result
decreased or kept
YES the same && ADC
result is lower than
the lower limit &&
Duty step down the Duty is able to
Duty step down
I
y
Set TMXn to
output the target

O

9.3.3 CHn dimming function (n =0, 1, 2)

CHn dimming start

NO

ADC result NO
Changed?

Stop TMXxx
output Calculate the target
level

Set new reference
level
Set related duty for
target reference
voltage
Set TMX to output
PWM

) 4

O
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Chapter 10 Cables

10.1 USB interface cable (Mini-B type)

Figure 10-1 USB interface cable (Mini-B type)

HES] m— ]

Series "A” Plug Series "Mini-B” Plug

Series "A" Plug  Series "Mini-B” Plug
&=

==l [7 3
==
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Chapter 11 Schematics

Please find the schematics attached to this document. To open the attachments view in
the Adobe Reader press the paper clip in the lower left corner of the window. To open the
attachment double click the EZ-LED1-002_Schematic.pdf.
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